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HESHEVerilogEHlFtr—:zc611

1 module comparel(equal,a,b); / /X F&comparel. v

2 //FRERLT, FRERAS, RNAHEDESAR

3 input a,b; / /R O R

4 output equal; //FEiRHOAME

5 assign equal = (a==b)? 1 : 0;

6 //FFHassigniE & FiEE FLIEE L R AR (e

7 //aZETbiE, equal#itAl; afihZTbE, equaliEiti A0
8 endmodule //FHEHEDEHR

iR

S3iThge = y, =17
1. VeriloglASitRasfs b 1Eeess: SEMUMEEHCEFEHATR
2, Verilogig Pt & REMIERE 5 R

o]

3. VerilogiERigOAESEEIEERM; b% )—»—D) equal
4, assigni$ERHEIEDMKAHESE, N



‘HESHEVerilogEHlFtr—:zc612

1 module compare2(equal,a,b); //i{5Zcompare2.v
2 input a,b;
3 output equal;
4 reg equal; //FHequal AFFEE, KkF=HHa,bH il Awire
5 always @(a or b) //alwaysiZiZiEs), fe=a. b ABRES,
6 //asib R ET e B FiTEELT
7 if(a==b) //aZTbiEf, equalfidi Al:
8 equal = 1;
9 else //afZETbef, equalfiti ~O.
10 equal = 0;//8#%. R fSelse HHL&=EHLFE?
11 endmodule
FEEIR = s
. . always ~

1. TS VerilogfwireSreg R = equal~not
RIS R, ) equal
2, alwaysHEEPIRMESEZN;

° \E DAB \‘ = . ———
3, if...else..iBRRREEITIEAMER; HE1E55 LHESERNBEE

4, PEZE (blocking) WEFS “=" .



HE g VerilogSERIEEr—=sc013

1 // Quartus Prime Verilog Template

2 // unsigned Adder

3

4 module unsigned_adder //FEHELREZF, HiniRELRTLE

5 #(parameter WIDTH=16) //FEZ=#, HLZEEHINE

6 B(

7 input [WIDTH-1:0] dataa, //FEHEARO, FLEE0%F
8 input [WIDTH-1:0] datab, //FBEEARD, HEELE
9 input cin, //EBRE RO, % AL
10 output [WIDTH:0] result //FEHEHEHRO, HFEE0%
11 |);

12

13 assign result = dataa + datab + cin;

14 //FIHassignidafliniEiz ERFLImiEMEE
15 endmodule //F-Ejﬁff;-:ighﬁﬁ

FIGENH =

1. {EREVZHGESHIN ;

2. SHNERGEMBRE.

BERI M — N4k 1 REUEIEEER1D?



HEHEVerilog=EhlfFtr—i0i5 =478

1. VerilogRX/NSHEXH, HPXEF2EANE;

2, Verilog{SSRI4FNEEIATS:
0: {KEBYE. &BiH0sk “{&R”
1: SR, 2iF1% "B”

XX FRERRARIBIERE | ESHE | wire | reg |

Z28kZ: JES R BiE AR TR E
(GE: FHHSEAZKNS) Zor—se
3. Verilogthwire S5regiii{5S 3833tk ; MRS s _(%é.j*g;%;g;)
4, JESIHFEHEFIXE. e e THAOBEIEE EREWEES
ke TEIE AR _I(assign) (ilways)

ToARENAPIRES yA X
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Quartus PrimesX{FEF{ERE- I+ T

- M Select All
EA#I:H&$: vIQuartus Prime Lite Edition (Free)
v/Quartus Prime (includes Nios Il EDS) Y
° EM . .
Qua rtus Prlme 1 7.0 ’Elﬂﬂﬁ A\ . 1.7 GB MD5: F95E47F859713C3C6DD59A94A9FC5E43

ModelSim-Intel FPGA Edition (includes Starter Edition)

Ay : 1.1 GB MD5: B3E4A6C66187D19BFF976FFB3566D967
TEME GEMETTE) -

M Devices
B IRE D R— N RT LRI BEERE Quartus PrimeRi4,
[_|Arria Il device support
v : 499.6 MB MD5: BDFCC96CB847AADEA46B8SFF4ESE1AQOB6G

v|Cyclone IV device support
K : 466.6 MB MD5: F36179518284561D5FAE66CF5B4748BC

https://www.intel.cn/content/

www/cn/zh/software/program

mable/quartUS' [_ICyclone 10 LP device support
. Ay : 266.1 MB MD5: DO726B51AEEFF72E88BCCD629A2C2A23
prl me/download~htm| iv|Cyclone V device support
Ay : 1.1 GB MD5: 978CC235B50DA9BCC95C709EDADE4503
Eﬁ{q:@mﬁ . IMAX Il, MAX V device support

Ay : 11.4 MB MD5: CDODC70DB8AFF4616DCFA7BBFD9BBD74

¥IMAX 10 FPGA device support
A : 325.1 MB MD5: A5499E644D470ECO609AF1B4E69CEBS3


https://www.intel.cn/content/www/cn/zh/software/programmable/quartus-prime/download.html

Quartus Primef{EERER- =5

XSS ERER— R T. WE
“QuartuslLiteSetup” BIRIFHARER.

- cyclone-17.0.0.595.qdz
- cyclonev-17.0.0.595.qdz
- max10-17.0.0.595.qdz
#., ModelSimSetup-17.0.0.595-windows.exe
| “., QuartuslLiteSetup-17.0.0.595-windows.exe




Quartus PrimefR{FE P {ER -0 4%

alnstal\ing Quartus Prime Lite Edition (Free) 17.0.0.595 -e
- - -

alnstal\ing Quartus Prime Lite Edition (Free) 17.0.0.595 bl
- — -

o 5

b

Installation directory

Select Components

Specify the directory where Quartus Prime Lite Edition [Free) 17.0.0.595 will be installed
Installation directory :E:\inleIFPGA_IiteU 7.0

InstallBuilder

[ <Back ||

Newt> | [ Cancel |

Select the components you want to install

=} Quartus Prime Lite Edition (Free)
Quartus Prime (includes Nios Il EDS) (7145ME]
=] Devices
Cyclone IV (516.3MB)
Cyclone V (1225 5MB)
Max 10 FPGA (335.6MB)
ModelSim - Intel FPGA Starter Edition (Free] (3981.2MB)
[7] ModelSim - Intel FPGA Edition (3381.2MB)

InstallBuilder

You can add additional device support to an existing
Quartus Prime software installation without having to
reinstall the entire software package. Use the Install I
Devices command on the Tools menu in the Quartus Prime
software to get started.

Select a component for more information

Nexst >

[ <Back ||

J [ concel |

IRERFIEE (EUEANMEE,
CRFRAEAEHNEEER)

BlahitiF 7 R EFRES 4T
TRSMAM



Quartus PrimefR{EEFER- G55

. Intel

B intel FPGA 17.0.0.595 Lite E... ~

= Design Space Explorer Il (Qua...

n Device Installer (Quartus Prim... ﬂ

EDA Simulation Library Comp... r—] ua rt s

ModelSim - Intel FPGA Starte... i‘::! 1E rt Us ..

ModelSim - Intel FPGA Starte...
Nios Il Command Shell (Quart...

Nios Il Documentation (Quart...

ios |l Software Build Tools f... et PN S .
N SER RSk S i FHAA T Y SR
Programmer (Quartus Prime... ,I*E*a.‘;]ﬁglx{q:

Quartus (Quartus Prime 17.0)



Quartus PrimeiR{FEF{ER-FE 1145

(G Quartus Prime Lite Edition

File Edit View FBroject Assignments Processing Tools Window Help

Prujecmavugatm{ 4\ Hierarchy = ‘Q aa x

i Compilation Hierarchy

TiESHn

[Tasks Compilation

Task

~ P Compile Design
> P Analysis & k

> P Fitter (Place & Routs)

> P Assembler (Generate programr
> P TimeQuest Timing Analysis
> P> EDA Netlist Writer

B Edit settings

Recent Projects

B TEST.qpf (E/TEST/TEST.qpn)

OrRd/+~T0hDC S EEX TP FES OAVE®
L

Home

E D Compare Editions

TiEHE
fErEL

B pontsnow thi

0] 5] &

[¥ sshiters>

‘ B Eind. | ‘m FlndMegl‘

=mx"~

‘L!; New Project Wizard

Support Vhats New

TR R REE
SREX

¥ Open Project Mo Selection Available
¥ Library

Basic Functions

> DsP
‘ Interface Protocols

Notifications

IP Catalog.
Device Family | Cyclone V (E/GX

v 3 Installed IP

¥ Project Directory

Memory Interfaces and Controllers

Processors and Peripherals

University Program
@ Ssearchfor Partner P

ER{HF IR
[SE

IPEO

+ add.

Type ID  Message

\

[ERIRET

&0

B

System  Processing




Quartus PrimeiRFEF{ER-FE21LIE

§ |

File | Edit View Project Assignments Processing Introduction
" New... Ctrl+N

~ The New Project Wizard helps you create a new project and preliminary project settings,
~ Open... Curl+0 1o = including the following:

Close Ctrl+F4 . Project name and directory

. . Name of the top-level design entity

New Project Wizard... ¢
= Ject i . Projectfiles and libraries
"5 Open Project... Ctrl+J . Target device family and device

Save Project ¢ EDA tool settings

Close Project You can change the settings for an existing project and specify additional project-wide

settings with the Settings command (Assignments menu). You can use the various pages of
E Save Ctrl+S the Settings dialog box to add functionality to the project.
g g ty proj

"ﬁ“ﬁ uFiIe" ﬁE-FHg V7] NeW
P rojeCt Wiza rd oo " %ﬁEIE Don't show me this introduction again

< Back H Next > H Einish H Cancel H Help




Quartus PrimeiRFEF{ER-FE21LIE

L New Project Wiz L New Project Wiz

Directory, Name, Top-Level Entity Project Type

What is the working directory for this project? Select the type of project to create.

C/DESIGN/test L) [ E—

Wi s mame e Ui el Create new project by specifying project files and libraries, target device family and

tegﬂ E device, and EDA tool settings.

What is the name of the top-level design entity for this project? This name is case sensitive () Projecttemplate

and must exactly match the entity name in the design file. Create a project from an existing design template. You can choose from design

test B templates installed with the Quartus Prime software, or download design templates from

the Design Store.

Use Existing Project Settings...

| <sack || mext> | Einish || cancel || melp ] <pack || Next> | Finish |[ cancel |[ Help
EETERE. TRETREREITLHE —

(ESREMapZmEn: F8HkL, 1 (%R “=TiE")
IREFEE TRIZ%. RUTRIZESER)




Quartus PrimeiRFEF{ER-FE21LIE

New Project Wi

(% New Project Wizar c“g

. Family, Device & Board Settings
Add Files !
' Device | Board |
Select the design files you want to include in the project. Click Add All to add all design files
in the project directory to the project Select the family and device you want to target for compilation.
prol Yy project. You can install additional device support with the Install Devices command on the Tools menu.
Wwitze yrare @em 2y a i) @l g ills d die prefe e To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.
File name: E] Add Device family Show in 'Available devices' list
Eamily: |Cycl V (E/GX/GT/SX/SE[S -
o x lﬁﬁdd = Eamily: [ yclone V (E/GX/GT/SX/SE/ST) ] Package: [Any _]
- . = 5 = —— Device: [All -l Pin count: IAny 'l
File Name Type Library Design Entry/Synthesis Tool HDL Version TETEE |
— Target device Core speed grade: IAny vl
Up Auto device selected by the Fitter Name filter:
T — @ Specific device selected in *Available devices' list Show advanced devices
—— Other: nfa
Properties

Available devices:

Name Core Voltage ALMs Total 1/Os GPIOs GXB Channel PMA
5CGXFC7CBUT9CT 1.1V 56480 268

Specify the path names of any non-default libraries. J L

GXB Channel PCS

<pack || Mext> | Enish || cancel || Help

< Back H Next > H FEinish H Cancel H Help

I LIERRRANEERITH e BinearIRS. HESHERRF
(RTHki) (ZFR LR AIfEEiEE)



Quartus PrimeiRFEF{ER-FE21LIE

(3 New Project Wiz

EDA Tool Settings

Specify the other EDA tools used with the Quartus Prime software to develop your project.

EDA tools:
Tool Type Tool Name Format(s) Run Tool Automatically
Design Entr... ‘<None> ~|<None> =[] Run this tool automatically to synthesize the current design

Simulation ‘ModelSim—Ah« ~ |VerilogHDL - Run gate-level simulation automatically after compilation
Board-Level Timing <None> ™
Symbol <None> ~
Signal Integrity |<None> ~ |

Boundary Scan |<None> n

| <gack || mext> || gnish || cancel |[ melp ]

IBEEDATE (il “Simulation” IH%iE “ModelSim-
Altera” , HHIRZKIA “None” {EHQuartusBisEH)




Summary

Quartus PrimeiRFEF{ER-FE21LIE

When you click Finish, the project will be created with the following settings:

Project directory:
Project name:
Top-level design entity:
Number of files added:
Number of user libraries added:
Device assignments:
Design template:
Family name:
Device:
Board:
EDA tools:

Design entry/synthesis:

C:/DESIGN/test
test

test

0

0

nfa
Cyclone V (E/GX/GT/SX/SE/ST)
S5CGXFC7CTF23C8

n/a

<None> (<None>)

Simulation: ModelSim-Altera (Verilog HDL)
Timing analysis: 0
Operating conditions:
Core voltage: 1.1V
Junction temperature range: 0-85°C
< Back ] | Next > | | Einish | l Cancel I l Help




Quartus PrimefRMEEP{E-F7EVerilog 3%

Eile Edit View Project Assignments Processing Tools Window Help

OFHEA00 2 C | [e= ) £ @S«

Project Navigator » Hierarchl (T3 New
Entity:In
New Quartus Prime Project -~
& Cyclone V: 5CGXFC7C7F23C8 . . | .
» tost 4 Design Files Verilogd.v a8 \—
es .
AHDL File — 5= 5= %67 | —
L \-\ —
Block Diagram/Schematic File 0 £ = D B‘ B) Ln] — ’D -
EDIF File E
Qsys System File
State Machine File
! | L I SystemVerilog HDL File L
Tasks lCompilation i Tcl Script File
— |Verilog HDL File |
as VHDL File
4 P Compile Design 4 Memory Files
> P> Analysis & Synthesis Hexadecimal (Intel-Format) File
> B Fitter (Place & Route) Memory Initialization File & %ﬁEf%EIJHg

) ool o ][ cnal | p I BEAVIHITARE

B e e

ik “File” TR “New...” FRE, %
igit324hiY “Verilog HDL File” #hiEVerilog3Xit



Quartus Prime XFEF{ER- iGN IERIERE

Heeo EEMNMRM T YIE:

& Insert Template \_

FRNRIR

Language templates:

4 Full Designs
> RAMs and ROMs
[> Shift Registers
I> State Machines
4 Arithmetic
4 Adders
Signed Adder
|Unsigned Adder

m

Chmmmed A Al r e IC et TA A Al

< i |

4 \erilog HDL -~

Preview:
// Quartus Prime Verilog Temp
// Unsigned Adder
module unsigned_adder
#(parameter WIDTH=16)
B(
input [WIDTH-1:0] dat
input [WIDTH-1:0] dat
input cin,
output [WIDTH:0] resu
);
assign result = dataa
<[ »

s

m

-

‘ Save ‘ l Insert l I Clos

e |

REMEHBRMRRIREEE,

EIF—P=ER VerilogigiHLHa
(MNEEFERNE—I RS INES)




Quartus Prime XFEF{ER- iGN IERIERE

|Er0|'ect Assignments Processing Tools Window Help

@ unsigned_adder.v 8
mesi EEMNM 0D VES
. {} =:— =:— [ 268 =
1 // Quartus Prime Verilog Template

2 // Unsigned Adder -

3 S

4 module unsigned_adder *EB&%\'—?SE#F%
(55 E#E(p:—.tr.'—.tmeter WIDTH=16) %M\—if{
7 input [WIDTH-1:0] dataa,

8 input [WIDTH-1:0] datab,

9 input cin,

10 output [WIDTH:0] result

11 1);

12

13 assign result = dataa + datab + cin;

14

15 endmodule

BARIR B RE

Add Current File to Project
% Add/Remove Files in Project...

' Revisions...
Copy Project...

Clean Project...

Archive Project...
Restore Archived Project...

Import Database...
Export Database...

Import Design Partition...
Export Design Partition...

Generate Design Partition Scripts...

Generate Tcl File for Project...

Generate PowerPlay Early Powgr Estim
Upgrade IP Components...

RESRINAA
JRESLIR

Organize Quartus Prime

B SetasTop-Level Entity

Hierarchy

Ctrl+Shift+J

>

IIEHZhQ

AKFF?SIIAE*{ZIS




Quartus PrimeiRFEF{ER-1Z=51T

= - Tasks Compilation v |=@e =
[Pmcessmg] Tools Window Help
- - Task
@ Stop Processing Ctrli+Shift+C 0% 4 B Compile Decion
1> Start Compilation Ctrl+L > P> Analysis & Synthesis
] ':(1 Analyze Current File \ > B> Fitier (Place & Route)
g

> P Assembler (Generate programming files)

s FHAR AT

Update Memory Initialization File *”ll‘;&}éﬁi

> P TimeQuest Timing Analysis
» P> EDA Netlist Writer

? Compilation Report W Edit Settings
&? Dynamic Synthesis Report » Program Device (Open Programmer)
£ PowerPlay Power Analyzer Tool 4 | i | 3
# SSN Analyzer Tool Tasks ICompilation ']E @ x
Receive Compilation Status Notifications Task
i « 4 P Compile Design
v > P Analysis & Synthesis
- ybé A4 v > P> Fitter (Place & Route)
w  Help / a | n’)H:IHl:F v > P Assembler (Generate programming files)
/ e G @ @ > " " O e ’I‘%]:%@*m v > P TimeQuest Timing Analysis
- = v > P EDA Netlist Writer

unsigned_adder.v (%] B Edit Settings

= = == m» s o= By ([2s7] = »ProgramDevice(Open Programmer)

I &

REFRmFREENITE R R IUH T RIE, o I1’E‘#F' =fap ED?&E% HE




Quartus PrimeiRFEF{ER-1Z=51T

Tools Window Help

Run Simulation Tool v h )

% Launch Simulation Library Compiler unsigned_adder.v a OCompilatit
8. Launch Design Space Explorer Il o7 = -
€ Timing Analyzer plate

Advisors »
e Chip Planner
e Design Partition Planner

Netlist Viewers Y Q RTL Viewer
~@ Signal Tap Logic Analyzer @ Technology Map Viewer (Post-Mapping)
# |n-System Memory Content Editor €& Technology Map Viewer (Post-Fitting)
& Logic Analyzer Interface Editor €% State Machine Viewer

=E “Tool” EETH) “Netlist Viewers”
FEETAHR “RTL Viewer” IH PhO Gy Add

A[16.0] OUT[16.0]
result[16..0]
B[16..0] D

cin[_>

1IN

1T'hO cin  AddO
dataa[15.01[>— All 6--% OUT[16..0]
datab[15.0][> B[16.0]

=

15:00 5:0
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FHAModelSim{FERE-GERIEFER

Ha=RhE?
(FEREATIMEFREIMARRIRYIERE, @EIREBIMARIIAYEED, B
TSR ES TSR,

SHERE) — | 5RE
1 }mm:
RTLEKEE| — RTLIRE RTL{FE
A | s .
E lﬁjﬁa o memiem | [IEHE
e N ‘ } ==
SR | rmmmsE




EHAModelSim{EERGE-HEIREER

Quartus Primefgi=pHE:

> RTUAE, (NAFEENESEIERE;

> [VRMEEFE, AEEE, RIEREBZIEIERTY,
> RRFGE, BERE, BIEAETER.

iRiTHY < HDLLfmmz

FHERIRE

- < BXBERE
O mERRE |

& N

yr— 4 o  ERHNES
Mt & (Testbench) o FEUAHER




fAAModelSim{pEGZE-R{Fi2E

IAssignments] Processing Tools Window Help
*

2 Device...

/" Settings... Ctrl+Shift+E
6 Assignment Editor Ay l=--| =
6 Pin Planner 1XE¥7KE

Remove Assighments...
I% Back-Annotate Assignments...
Import Assignments...
Export Assignments...

Assignment Groups...

Alt+L
Alt+D

LogicLock Regions Window

7= Design Partitions Window

s=E “Assignments” TR
“Settings...” FEREHANRE
TaHE, ®F “Simulation” FIR
EEMEIR
“ModelSim-Altera”

. Settings - test

00 Cr ey

Category:

General
Files
Libraries
4 |P Settings
IP Catalog Search Loc:
Design Templates
4 Qperating Settings and ¢
Voltage
Temperature
4 Compilation Process Set
Incremental Compilati
4 EDA Tool Settings
Design Entry/Synthesi
Simulation

Board-Level \\
4 Compiler Settings

VHDL Input

Verilog HDL Input

Default Parameters
TimeQuest Timing Analy
Assembler
Design Assistant
SignalTap Il Logic Analy:z
Logic Analyzer Interface
PowerPlay Power Analyz
SSN Analyzer

Device/Board... I

Specify options for generating output files for use with other EDA tools.

Tool name: IModelSir‘n—Ahera

Run gate-level simul§fion au

EDA Netlist Writer settings

Format for output netlist: |Ver

ToC

1EEEModelSim-Altera

e stae T

Qutput directory: simulation/modelsim
Map illegal HDL characters Enable glitch filtering

Options for Power Estimation

Generate Value Change Dump (VCD) file script |Script Settings...

[x

Simulation—=I1

\More EDA Netlist Writer Settings... I

Nativelink settings

@ None

©) Compile testbench: |

- | |T‘5‘5t Benches... ‘

["] Use scriptto set up simulation: ‘

© Script to compile test bench: ‘

{More ﬂativeLinkSettings...]

OK H Cancel H Apply ||

Help




i Model

Sim{(FERBE-IHFEE

Tools | Window Help

Run Simulation Tool
4 Launch Simulation Library Compiler

¥8. Launch Design Space Explorer Il
e TimeQuest Timing Analyzer
Advisors

@ Chip Planner
e Design Partition Planner
Netlist Viewers

=@ SignalTap Il Logic Analyzer

@ In-System Memory Content Editor

E Logic Analyzer Interface Editor

E In-System Sources and Probes Editor
SignalProbe Pins...

» Programmer

O}\ JTAG Chain Debugger

» Fault Injection Debugger
System Debugging Tools

Nios Il Software Build Tools for Eclipse

_a Options — .

— -
EDAIE-J‘&M?I-D;I -

Category: I
| |4 General l EDA Tool Options
[EDA Tool Options Specify the directory that contains the tool executable for each third-party EDA tool: |
Fonts
Headers & Footers Settir | | EDA Tool  Directory Containing Tool Executable
» 4 Internet Connectivity Precision ... B
Notifications
Synpli
Libraries ynplify B
4 |P Settings synplify ... B
» IP Catalog Search LOC | | Active-HDL E]
I Design Templates »
License Setup Riviera-P... E
Preferred Text Editor ModelSim B
Procatssmg i QuestaSim E]
Tooltip Settings
4 Messages ModelSi...  C\intelFPGA\17.0\modelsim_ase\win32aloem E
Colors
i Fonts

JETEModelSim-Altera
' TEZEHS

Use NativeLink with a Synplify/Synplify Pro node-locked license

'—.‘ IP Catalog
&t
Fd

Jijiey == 'K —— [ ok [ cmce |[ e |

¥

Qsys
Tcl Scripts... >
? TE-%
Customize...
Options...

License Setup...
° Install Devices...

=i “Tools” EATHY “Options...” FREHNIGERHE, #F
“EDA Tool Options” FIUEEHFETE “ModelSim-Altera” AIIEE




R EModelSim{FE R E-TestbenchiEtz &= kY,

Processing | Tools Window Help

=i “Processing” ZEE

TRy “Start” FEETH
“Start Test Bench

Template Writer” F3
B pf Testbenchi&tli

(EIEBR TR

“simulation\modelsim’

X{4Jeq)

(4

Stop Processin Ctrl+Shift+C
® stop Processing 9 © &
P> start Compilation Crl+L Compilation Report-test B
%Y An alyze Current Eile
Start * *a Start Hierarchy Elaboration
Update Memory Initialization File > Start Analysis & Elaboration
? Compilation Report Ctrl+R . Start Analysis & Synthesis Ctrl+K
| B e el %% Start Partition Merge
F 4 PowerPlay Power Analyzer Tool % StartFitter
Bt SSN Analyzer Tool wl  Start Assembler
Receive Compilation Status Notifications ° Start TimeQuest Timing Analyzer Cul+shift+T
~=[@# = % Start EDA Netlist Writer
—_— | . .
Assembler l % start Design Assistant
[ M TimeQuest Timing Analyzer
© . . g Y 1L Start PowerPlay Power Analyzer Ctrl+Shift+P
[> B9 EDA Netlist Writer T
HE  Start SSN Analyzer
® Flow Messages 1
© Flow Suppressed Messages 1!‘:; Start Rapid Recompile
mming files) 1% start SignalProbe Compilation Ctrl+Shift+l
“’.“’ Start 1/O Assignment Analysis
*8 start i
1 = s —
Y/
] tart TeStbenCh1:E1:ﬁ€EEJZ 3 7&%
nmer) 1 Start -
] ~ I = 5 Start Test Bench Template Writer
~ % Start EDA Synthesis




AAModelSim{AE R E-TestbenchiEfE51EES

28 “timescale 1 ps/ 1 ps . .
DN 29 moduTe unsigned_adder_vig_tstO); | F{EJER{Y/BY[EAEE
MP (C: - - - 30 // constants
(C:) » DESIGN » test » simulation » modelsim 31 reg eachvec;

32 // test vector input registers

23 33  reg cin;
7 34 reg [15:0] dataa;
FER Eit) K 35 reg [15:0] datab;
36 // wires
test.sft SFT 7 1kg 37 wire [16:0] result;
ests # 38 // assign statements (if any)
testvo VO i 40KB 39 gunsigned_adder i1 (
test_modelsim.xrf XRF 3744 skg 40 |// port map - tion between master ports and signals/registers
igned_adder.vt VT 3244 3KB 3 -cingein),
~ unsigned_adder. 42 .dataa(dataa), ME Ay B N
- 43 .datab(datab), UEIEHLXL‘I'E’\JJJD%%%
unsigned_addervtbak BAK 3Z{& 4 KB 234 | result(resuln);
45 initial
46 wmbegin
47 // code that executes only once
;]HIEE%TE{] 48 |// 1insert code here --> begin
. o . 49 // --> end
"simulation\modelsim” 50 |Sdisplay("Running testbench™;

MR & 3. viad 2 atways

e 53 // optional sensitivity Tist
TestbenCh*EWX‘tl:) gzst é/ @(eventl or event2 or .... eventn)
Ebegin
56 // code executes for every event on sensitivity list
57 // insert code here --> begin
58 |@eachvec;
59 // --> end
60 end
61 endmodule



AAModelSim{AE R E-TestbenchiEfE51EES

initial
Jbegin
// code that executes only once
// insert code here --> begin N =0
#0 c¢in=1'b0; dataa=16'h0: datab=16'h0;/ BEARNESYAE

#10 cin=1"bl; dataa=16"h2; datab=16"hl;—— | 1810/ B EIEA{T
#10 cin=1'b0; dataa=16'hl; datab=16"'h3; A E/\JIEAEI‘}TI\?EELLE
#10 cin=1'bl; dataa=16'h3; datab=16'h3; i
#10 c¢in=1'b0; dataa=16'h0; datab=16"h0;
// --> end
$d15p1ay(“Running testbench™);

Test Benchi&Etr3Z{4HhiE
NS SERATE
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SO0 rravw i
Category |

" Settings - test

General Simulation
Files Specify options for generating output files for use with other EDA tools.
Libraries
4 |P Settings Tool name: [Modelsim—Allera ']

IP Catalog Search Loc:
Design Templates

4 Operating Settings and ¢ EDA Netlist Writer settings

Voltage
Format for output netlist: |Verilog HDL A Time scale:

Temperature
Outputdirectory: simulation/modelsim E

Run gate-level simulation automatically after compilation

4 Compilation Process Set
Incremental Compilati
4 EDA Tool Settings

Design Entry/Synthesi
Simulation e—

Map illegal HDL characters

Simulation=FIg |+

4 Compiler Settings ‘

11E3F (s Testbench

Verilog HDL Input
A ‘ ‘Teg( Benches... ‘

Enable glitch filtering

Board-Level

Default Parameters
TimeQuest Timing Analy
Assembler

Design Assistant
SignalTap Il Logic Analyz
Logic Analyzer Interface
PowerPlay Power Analyz
SSN Analyzer

) Compile testbench: ‘

["] Use scriptto set up simulation: ‘ H:‘

(©) Scriptto compile test bench: | H:‘

More NativeLink Settings...

mmen (s ———( T | ==

s “Assignments” TS
“Settings...” FREHNZERE, ®F
“Simulation” FIR, 1#%FE(FERHTestbench

TestbenchX {443

Test bench name: unsigned adder

Top level module in test bench: unsigned adder vlg tst

Use test bench to perform VHD] timing simulation

U Testbench XA TR EE DR

Simulal

) Run simulation until all vector stimuli are used

) End simulation at: ‘ ‘ |5 '|

Test bench and simulation files

File name: odelsyfunsigned_adder.vt E Add

File Name  Ubrary HDL Version | Remove
5xE lestbench3Z{4
‘ Down ‘
‘Eroperties... ‘
OK I l Cancel l l Help l
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[Tools | window Help RTUBEE P~

Run Simulation Tool Pg\ RTL Simulation

r—_lg&ﬂ’j—g = Gate Level Simulation... i " More EDA Netlist Writer Settings X

_-IILL,“\E u TOOIS" ﬁE-FHg “Run Slmulatlon TOOIH )S{zj:::z:jr;:ettings for the EDA Netlist Writer options in
FRETHANFREIBHITRTLGEHIRIGE.

%+ Launch Simulation Libr

‘ & <<Fijlter>> ‘ Show: ‘All v

. L1 IMIdp 1egdl aUL Cnaraclers Name: ittir
v EDA Tool Settings P iee

Design Entry/Synthesis Options for Power Estimation Flatten buses into individual nodes Off

Simulation Generate functional simulation netlist
|:| Generate Value Change Dump (V

Board-Level Generate third-party EDA tool command script...

v Compiler Settings Design instance name: Generate third-party EDA tool command script../ Off
VHDL Input
> L\b
Verilog HDL Input [ Pl < j:]';:FEEEJZIjJ 1E >
Default Parameters |More EDA Netlist Writer Settings... ,‘_'__..’,' Descripti
o p — BRI T

R
ol TVEUEREL | =
Reset All

| OK H Cancel H Help ‘

EDA simulation tools. When this v
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Junsigned_adder_vig_tst/eachvec
Junsigned_adder_vig_tst/dn
Junsigned_adder_vlg_tst/dataa
funsigned_adder_vig_tst/datab
Junsigned_adder_vig_tst/result

funsigned_adder_vlg_tstfeachvec
Junsigned_adder_vlg_tst/cin
funsigned_adder_vlg_tst/dataa
funsigned_adder_vig_tst/datab
Junsigned_adder_vig_tst/fresult

RTLIFEER (TEHEIEAESR)
(BENEREREREESRIENSSHETRA)
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4 Junsigned_adder_vlg_tstfeachvec
4 Junsigned_adder_vig_tst/dn
-4 Junsigned_adder_vlg_tst/dataa
-“ Junsigned_adder_vig_tst/datab
' Junsigned_adder_vig_tstjresult 0

0 | 0
_ |
EX B ————————

ENFAESER (HiHEEEUER)
( AZIFLUTES: Arria 1l GX/GZ,Cyclone IV, MAXII, MAX V, Stratix V)

26 //
.
28 timescale 1 ns/ 1 ns

(AH4?)
IR R {AERIFc(Ei Testbench
A aS RN RS BFEE






